Upgrading Guide WebSite Tonight

Upgrading WebSite
Tonight 2.7 to 4.x

We've improved our software—here's how to take advantage of it!

Quickly and easily upgrade to WebSite Tonight v4.x and get access to many new features that
will help take your Web site to the next level. New features include: changing your layout
without losing content, recording videos for your site, flash intros, subnavigation, 8,000 stock
images, and integration with Google Webmaster Tools.

What am | going to learn from this guide?

We want to help you get up-and-running ASAP with the new version of WebSite Tonight. Here's what
we'll cover in this guide:

« Upgrading Your WebSite Tonight 2.7 Project
« Changing Your Template

« Manually Importing Your Content

« Organizing Your Site

» Navigating WebSite Tonight

« Previewing and Publishing Your Site

Upgrading Your WebSite Tonight 2.7 Project

1. Login to your Account Manager.
2. In the My Products section, click WebSite Tonight.

3. Inyour Account List, click Launch for the account you want to work with.

[] anvdomainanywhere corm Leunch
WebSite Tonight Deluxe - 10 Page Web Site - 1 year

4. Click Import Site.

Import your site to WebSite Tonight v4.8.3 Recreate your site in WebSite Tonight v4.8.3
All of your pages and content are seamlessly brought into This starts your site design and layout completely from
this new version. You can choose from many templates scratch. However, your content remains available to import
and options on the next page. into the page designer.

Import Site Recreate Site
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Click Accept to accept the terms of the End User License Agreement.
On the Site Settings page, complete the following fields:

+ Email Address — Forms submitted through your site are sent to this email
address.

« Company or Individual Name — Your company or individual name
displays in the footer of each Web page.

Click Next.
On the Build Your Site page, select one of the following:

« Begin with a clean slate for your Web site — Your content will be
imported with a Clean Slate template. This is recommended for advanced users.

« Choose from over 150 great designs — Your content will be imported
using a WebSite Tonight template. This is recommended for most users.

9. Ifyou selected to begin with a clean slate, you're brought to the Page Designer to
begin building your site. If you selected to choose a template, you're brought to the
Template Selection screen.

If you need to change your template, see Changing Your Template. If you are ready to begin working
with your imported content, or import additional content such as headers and footers, see Manually

Importing Your Content.

Copyright© 2009




Upgrading Guide WebSite Tonight

Changing Your Template

You can change your template at any time without losing the content you added.

1. Click the Template tab.

Step 1. Select a Design Step 2. Apply Your Design
Template Options I I Your Site
(55 See Mors Templates
. assign accourt . assign Accourt
i M I Back up site hefors updating
E :' Current Template Current Template Current Template

Not assigned Mot assigned

| 2 )
Boutigue figw larder previes
|
Category: Gereric
Template: Clean Slste
n Works With: || |

g I
L 1] ]]

Cnstinn Cal =l Work on My Site

Change Template Screen

2. Inthe Available Templates area, you can do one of the following:

« Scroll through the templates available in the Category you previously selected
during setup.

+ Click Filter and complete the following for a more advanced search:

Category
Select a category that best describes the type of site you want to build.

Templates that work with

Click the icon(s) that represent the product(s) for which you want to use the
template, and then click Update. For example, if you want your Web site to
match your shopping cart, select both Site and Store so only templates that

work with both display.
# NOTE In the Available Templates area, change the color scheme of your u [
template by clicking one of the color swatches next to the
thumbnail of the template. I
=

3. Click a template thumbnail to select it.
4. Click OK.

To go to the Page Designer and check out your site, do the following:
1. Click the Site tab.

2. If necessary, select Launch Page Designer from the Design menu.
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Manually Importing Your Content

The import site option imported all of your 2.7 body content, but did not import any header or footer
content. The pre-built site and blank site options did not import any of your 2.7 content. Whatever
your situation, let's fix it.

To Import Your Content

1. If necessary, from the Design menu, click Page Designer.

2. If necessary, from the You are editing list, select the page that contains the block
you want to import to.

kTIP If you selected a Pre-built site or Blank site when upgrading, you may need to add or
rename pages the Pre-built site added. See the Organizing Your Site section for
assistance.

3. Move your mouse to the block you want to add imported content to.

w What is a Content Block?
= T
School News
Content blocks are containers for

P e e e information in WebSite Tonight.

i .
Perfect Attendance Winnerl}g? First Se: Each page uses a layout containing

:All students who had perfect attendancein th content bIO_CkS' The _organization of
Falace gift certificate. Those who have perfac the blocks is determined when you
:year will earn free passes to Wally World. Co: choose your page layout.

1
:The students with perfect attendance for the You can add, share, move, and de-

" e Kindergarten - Jake Jones - Ms. Bella lete content blocks.

4. Go to the Options tab and click Import.

| Page | Insert | Options |

B @ [A1]

Delete Block Share Irnport Clear

Block

5. Select the content you want to import from the following fields:

« Select the Backup - The version of your Web site that contains the content
you want to import. The first time going through, you will have no other
backups so this field will not display. It will automatically pull from your 2.7

Copyright© 2009




Upgrading Guide WebSite Tonight

project.
+ Select the Page - The page that contains the content you want to import.

+ Select the Page Section — Select whether to import Heading, Body, or Footer
content.

Import Coanient

Shisp 12 Salect i P ase

|Buy & Car =l

Soisp ¥ Sabici M Page Semsn

22 =

Hazpding
|Body
Foatier

-
il I

T S | €¥tia =
o] Careel
HTIP You can preview the imported content in the Content Preview window.
6. Click OK.

If you're having some problems with the way things are importing, check out the Troubleshooting
section.
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Organizing Your Site

If you chose to import your site when you upgraded, WebSite Tonight imported all of your pages. If
you chose the Pre-built site option, then you have up to five pages that could be named differently than
the pages that were on your previous site. If you chose the Blank site option, you only have one page
that's called the Home page.

Let's get your page structure to match what it was in version 2.7. To do this, you'll need to get familiar
with the Organize Site page.

P TIP Your 2.7 site should still be published and visible on the Internet. You can check out
your site structure there and then go to the Organize Site page and make sure your
new site matches.

To Rename Your Pages
1. From the Manage menu, click Organize Site.

2. From the left side of the screen, click the page you want to rename.

3. Inthe Page Properties area, complete the following fields:
« Button Title — The text that displays for this page on the site's navigation.

» Browser Title — The text that displays in the browser's title bar.
» Heading Title — The heading text that displays on the published page.
+ Filename — The name of the file that displays in the browser's URL bar.

4. Click OK to save your changes.

To Add New Pages
1.  From the Manage menu, select Organize Site.
2. Click Add Page.

3. Select Blank Page or Pre-Built Page. If you select a pre-built page, select a site type
from the Site Type list and a page from the Page list. Pre-built pages are pages that
contain a design and sample content based on the selected site and page type.

4. Inthe Enter Your Page Title field, enter a title for the page.
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5. Ifyou are adding a blank page, specify the layout you want to use. If you selected a
pre-built page, the layout is selected for you.

Click OK.
If your new page will be your home page, select Make this page the Home Page.
If you don't want the page to be published, select Do not publish this page.

© ® W o

In the Button Title field, enter the name you want to display on the button that
links to this page from other pages.

10. Inthe Browser Title field, enter the title you want to display in the browser's title
bar.

11. Inthe Heading Title field, enter the main heading for the page.
12. In the Filename field, enter the name you want to save the page as.

13. To allow WebSite Tonight to automatically reset the navigation buttons on your Web
site pages to reflect changes you made on the Organize Site page, select Reset page
navigation.

P NOTE This will overwrite any settings or subnavigation you may have added from the Edit
Navigation page.

14. Click OK.
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Navigating WebSite Tonight

The new version of WebSite Tonight consists of two main screens, the Home Page and the Page
Designer. If you're following through this guide step-by-step, you're on the Page Designer right now.
As tempting as it is to begin right away, take a few minutes to cruise through WebSite Tonight and
learn your way around.

In this section, you will:

 Discover a few options available on the Home Page
« See how to get to the Home Page from the Page Designer and vice versa

« Learn about the Page Designer and how it helps you design your site

Home Page

WebSite Tonight's administrative functions are available through the Home Page. The Home Page
displays when you first log in to your account.

Site Information Get Started
Last Publish: Site kot et Published
Pages used: Zof 5 £ Ly . L )
Edit site information ADD M ORE
Design Your Pages Add Pages Upload Files and Images FEATURES!
Template: Cenetic & Clean Slate
Change
Template
Tools and Resources Domain Search
) Hosting Settings ) Google Webmaster Tools |
Design: @ Visitor Statistics ) Back Up/Restore
Select pags... ;|| ) Password Protect ) Organize Site

1 Spell Check ) Restart Site

WebSite Tonight's Home Page

A few things to do on the Home Page include:

« See the number of pages your site uses in the Site Information area
« Upload Files and Images from the Get Started area.

+ Click Hosting Settings from the Tools and Resources area to set up your statistics
and see how many people are visiting your site

P TIP Click Home to get to the WebSite Tonight Home Page.

Design ~ Add-Ons Manage Seftings Help
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WebSite Tonight

Page Designer

The Page Designer lets you add text, images, tables, forms, and other content to your site.
The Page Designer has two parts:

« The WebSite Tonight toolbar

o The WYSIWYG (What You See Is What You Get) Editor

To Launch the Page Designer

1. From the Design menu, click Launch Page Designer.

Hu:ume_é Design =  Add-Ons - | Manag
Launch Page Designer,
Template and Colors

Advanced Style Options

Advanced Color Options

Understanding the Page Designer Toolbar

The toolbar contains options to modify text, change layouts, and insert items like images and movies

Home  Design Add-0Ons Manage Settings Help Qpreview 53] Publish
_I Size _I = == = % | Page || Insert || Options | Pager|HDme_Page (Home [LI FuIIScreen@@g
B @ | B 7 U =E == S |@ = B 7 & &F Q
Add Pages Change Layout  Edit Havigation Properties Preuview Page
4 O D9 o x X 2 (i B X
The Page Designer toolbar

P TIP The toolbar updates based on your selection in the content blocks in the lower portion

of the page. For example, click an image in a content block and you'll see an Edit
Image option in the toolbar's Options tab.
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Using the WYSIWYG Editor

The WYSIWYG editor lets you add content—text, images, tables, movies, music, and other items—all
with the click of a button, or buttons.

WYSIWYG editors make designing a site easy. There is no second-guessing how your site is going to
look.

.......................................................................... 1

YYZ Small Business Inc. :

1
e B e e e e e e e e i e e e e e e e S

| Click here to add text and insert objects

it your trust in VY Z Small Business Inc. Yve provide
kersonal service and exceptional guality. A1 of our services and !
roducts are guarantesd. We ha.ave been in.!?usmess far the nearly, | Click here to add text and insert oljects
i 0 years. Our unparalleled service, competitive prices, and overall |
jvalue are why our loysl customers won't go anywhere else. YWe 1
gook forvward to serving youl

The Page Designer WYSIWYG editor

Previewing and Publishing Your Site

To see how your site is going to look, use the Preview feature. When you're sure your site displays as
you want, you can publish it to make it live on the Internet. Once you publish your site, your 2.7 site
design is replaced with your new 4.x design. You can still import it your 2.7 content, but you cannot go

back to the previous site.

To Preview Your Web Site
1. From the top right corner of the page, click Preview.

(), Preview £ Publish

Page: | Home_Page (Home F;l Full Screen () Help

The Preview opens in a new window.
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To Publish Your Site
1. From the top right of the page, click Publish.

(), Preview 51 Publish

Page: | Home_Page (Home [+ Full Screen () Help

2. To publish your entire Web site, click Publish All. If this is your first time
publishing your Web site, Publish All is the only option. To publish only pages you
make changes to, click Publish Updates.

Publish

& Puplish web Site
© publish Coming Soon Page  (Why cant | select this option?)

™ Back upWeh site prior fo publishing

Publish Updates __Publish All

P TIP Changes to your site do not display on the Internet until you publish your site. Publish
your site as often as necessary, but pay attention to the number of backups and how
much disk space they consume. You can delete backup files to conserve disk space.

Getting Help

The Help Center is available from within WebSite Tonight in the upper right corner.

EL Presiessy 51 Publish
Page: | Home_Page (Home 1= Full Screen | (&) Help

When you click Help, the Help Center opens in a new window. Help is context sensitive. For example,
click Help on the Page Designer and the Help Center opens with additional information about the Page
Designer.

When you're in the Help Center, you can perform searches for any additional information you need.
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